
www.image-en-relief.org

Mars 2020

n° 1029 Association pour l’image en relief

fondée en 1903 par Benjamin Lihou

LLeettttrree mmeennssuueellllee

Activités du mois.........................................................................................2
Le Florilège arrive !..................................................................................... 3
Vingt-sixième Phot'Aulnay...........................................................................4
Séance parisienne du 12 février 2020.........................................................6
Séance parisienne du 19 février 2020.........................................................9
Union Stéréoscopique Internationale (ISU) : Adhésions et renouvellement.
Appel aux images stéréo pour l'ISU CODE.............................................. 13

Nouveaux produits.................................................................................... 14
Clubs stéréos étrangers............................................................................ 16
Vu sur la toile............................................................................................ 18

Dromadaire au Salon de l'Agriculture 2020, Paris
Photo : Pierre Meindre



Page 2

LLeettttrree mmeennssuueellllee dduu SSttéérrééoo--CClluubb FFrraannççaaiiss

nn°°11002299 -- MMaarrss 22002200

RRééuunniioonnss àà PPaarriiss 1144ee

• LOREM, 4 rue des Mariniers (Rez-de-chaussée de la tour au bout de la rue à gauche)
Métro Porte de Vanves ou tramway Rue Didot.

MERCREDI 4 MARS 2020 à partir de 14h00, au LOREM
Séance de travail - mise sous pli

• Nous ne serons pas trop nombreux pour la mise sous pli en vue de l'AG, avis aux bénévoles

VENDREDI 6 au DIMANCHE 8 MARS 2020 à Chelles (77)
Chelles Multiphot, 40e festival de l'image projetée

Au théâtre de Chelles - http://www.multiphot.com/
• Le samedi de 14 à 19 h : animation d'un atelier "Portrait en 3D" par le SCF.

MERCREDI 11 MARS 2020 à partir de 19h30, au LOREM
Séance mensuelle de projection

• Apportez vos montages, photos et vidéos pour les voir en projection • Discussion
constructive et réponses aux questions sur les techniques correspondantes

DIMANCHE 15 MARS 2020, de 9 à
18h, à Chelles (77)

40e Foire photo ciné son - http://foirephoto.com/
• Rencontre des collectionneurs • Théâtre de Chelles, Place
des Martyrs de Châteaubriant • L’accès est libre et gratuit.
• Comme chaque année, le Stéréo-Club Français y tiendra
son stand. Nous vous attendons donc nombreux, comme
simples visiteurs ou pour nous aider à tenir le stand du

Club au cours de la journée.

MERCREDI 18 MARS 2020 à partir de
19h30, au LOREM

Réalité virtuelle et stéréoscopie avec le Pr. Fuchs
• Intervention de Philippe Fuchs, professeur, responsable
de recherches sur la réalité virtuelle depuis 25 ans, auteur
de "Théorie de la Réalité Virtuelle, les véritables usages"

• Voir Lettre n°1027, pages 4 & 5.

MERCREDI 25 MARS 2020 à partir de 18h30, à Paris
Assemblée Générale du Stéréo-Club Français

• L'Assemblée Générale se tiendra à la Maison de la Vie Associative et
Citoyenne - 22 rue Deparcieux - 75014 Paris, comme l'année précédente

• Rapports moral, d'activité, financier, budget prévisionnel, candidatures au CA
• Membres du club, si besoin mettez-vous à jour de votre cotisation 2020

GGrroouuppee rrééggiioonnaall NNoouuvveellllee--AAqquuiittaaiinnee
DIMANCHE 29 MARS 2020 à partir de 10 h à Blanquefort

Maison du Patrimoine, allées de Carpinet - 33290 Blanquefort
Au programme : • Réunion technique : réalisation de fantôgrammes, de la prise de vue

au visionnage • Questions diverses
• Projection de nos montages et de vues tirées des liens du bulletin

Contact : Christian Garnier - photo.garnier@wanadoo.fr
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MERCREDI 1er AVRIL 2020 à 19h précises, au LOREM
Conseil d'Administration du Stéréo-Club Français

• Formation du nouveau bureau du Club • Les membres du Club peuvent être invités à
assister (sans droit de vote) aux réunions du conseil, sur demande adressée au président

president@image-en-relief.org

VENDREDI 3 AVRIL 2020 à partir de 14h00, au LOREM
Séance technique et pratique

• Démonstration macro-stéréoscopie à images multiples pour lenticulaire
• Afin d'alimenter un écran lenticulaire auto-stéréoscopique, le Lorem a construit un système
de prise de vue macro avec focus-stacking, automatisé pour des prises de vues multiples

MERCREDI 8 AVRIL 2020 à partir de 19h30, au LOREM
Séance ouverte : vos questions, vos essais

• Venez avec vos interrogations, vos essais
• Vous pouvez également faire part de vos questions à l'avance : president@image-en-relief.org

MERCREDI 22 AVRIL 2020 à partir de 19h30, au LOREM
Séance technique et pratique

• Optique surprenante sans formules (sous réserve de disponibilités)

MERCREDI 29 AVRIL 2020 à partir de 19h30, au LOREM
Séance mensuelle de projection

• Apportez vos montages, photos et vidéos pour les voir en projection • Discussion
constructive et réponses aux questions sur les techniques correspondantes

LLee FFlloorriillèèggee aarrrriivvee !!

L e Florilège, 260 images réparties en
36 thèmes sur 84 pages en format A4,

va bientôt être envoyé gratuitement à
tous les adhérents.

Ces « 36 apparitions du
relief dans l'image » consti-
tuent un recueil d’images
stéréoscopiques, choisies
pour illustrer l’intérêt spéci-
fique de la stéréoscopie (im-
mersion, présence, ape-
santeur, jaillissement, hyper-
stéréo, etc.).

La stéréoscopie nous
transporte dans l’espace du
lieu représenté, nous im-
merge, et crée une impres-
sion de présence inégalée.

Notre regard change par
rapport à une image
« plate » en parcourant les
différents plans, en étant surpris par des
sujets qui semblent prendre leur autono-
mie par rapport à la surface de l'image.
Nous percevons directement le relief de

l'infiniment petit, de très grands espaces
ou des mondes artificiels obtenus par tru-
cage, montage ou par images de syn-

thèse…
J’ai parcouru la masse

impressionnante des images
réalisées par des membres
du club durant la dernière
décennie, conservées par
le club, ou transmises par
ceux qui les avaient pré-
sentées en réunion. Un pre-
mier examen de cette
extraordinaire diversité a
débouché sur un classe-
ment par thèmes, dont le
nombre s’est révélé rapide-
ment très proche de 36, ce
qui fait songer à la diversi-
té des 36 vues du mont Fuji
de Hokusai. Par ailleurs, la

stéréoscopie fait apparaître le relief à par-
tir d’un couple d’images plates, cela fait
penser aux célèbres apparitions 1) de Sal-
vador Dali ; d’où le sous-titre.

mailto:president@image-en-relief.org
mailto:president@image-en-relief.org
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Ce n’est donc pas un podium des

meilleures ou des plus belles images, mais
d’abord l’illustration de la diversité des ap-
ports particuliers du relief en matière de
photo, choix arbitraire couplé aux
contraintes de mise en page.

Comment voir ces images présentées
sur papier ? De nombreux stéréoscopistes
pratiquent la vision parallèle 2) ; pour eux la
meilleure présentation est un couple en côte
à côte avec un écart des points homologues
proche de 6,5 cm (cf. Lettre mensuelle).
D’autres pratiquent la vision croisée ; l’in-
version droite-gauche est souvent dispo-
nible pour des publications électroniques,
sur papier cela double la surface, mais sans
couvrir tous les besoins. Pour d’autres en-
core et pour la plupart des non-stéréosco-
pistes, il faut un stéréoscope, au sens large.

Au printemps dernier nous avons re-
cherché le meilleur stéréoscope suffisam-
ment simple et d’un prix abordable. Il
existe des lorgnons, paires de lentilles
simples, comme pour le Livre du centenaire
du club en 2003. De plus, dès le XIXe siècle,
pour visionner de grandes plaques photo-
graphiques et des cartes stéréoscopiques,
on a utilisé les bords des lentilles pour leur
effet prismatique ; c’est ce qui est utilisé
par le Loreo Lite et le « OWL » de la London
Stereoscopic Company. Cela permet d’utili-
ser des images un peu plus grandes. La
qualité d’impression est aussi importante
pour éviter de distinguer la trame.

Charles Couland a mené une expérimenta-
tion en utilisant le Loreo Lite, cela auprès d’un
public d’amateurs de photographies, non
stéréoscopistes, à la Foire de Bièvres. Il a ini-
tialement calculé la distance entre l’image et
les lentilles prismatiques formant une image
virtuelle telle que l’accommodation et la

convergence coïncident, ce qui détermine
aussi la taille adéquate pour l’image. Il a réali-
sé le petit support correspondant. Ce dispositif
a montré son efficacité : 95% des spectateurs
ont pu fusionner rapidement ; des variantes
ont montré l’importance du réglage de la
distance. L’échantillon était réduit, mais le
taux de réussite rend le résultat significatif : la
grande majorité de ce type de public doit pou-
voir « voir en relief » facilement si on lui pré-
sente un couple stéréo de la bonne taille à la
bonne distance de lentilles prismatiques.

Plusieurs types de « binocles » ont été
examinés, et Charles Couland a réalisé les cal-
culs pour Lentille BUXIN, Lite OWL et la Lor-
gnette Stereoworld. Le OWL a été retenu sur
des critères combinés de qualité, d’angle de
vision et des aspects pratiques. On remarque
que ce même OWL permet de visionner des
couples stéréoscopiques sans pixellisation
bien visible sur des téléphones, grâce à l’aug-
mentation récente de la définition des écrans.

Pour placer les binocles à la bonne
distance, plusieurs types de support ont été
esquissés pour aboutir à un modèle carton
réalisable avec la découpeuse laser du Lorem.

C’est donc un ensemble comprenant le
Florilège, le OWL Lite, le support carton et
des lunettes pour anaglyphes qui sera en-
voyé. Cet ensemble devrait faciliter la pré-
sentation de la production du SCF à un
large public non initié.

François Lagarde

1) Notamment : « Marché d’esclaves avec apparition du
buste invisible de Voltaire » ; bien d’autres tableaux sont
à lecture multiple.
2) Les stéréoscopistes voyant en parallèle sont majori-
taires parmi ceux qui ont répondu à un questionnaire de
la revue « Stereoscopy » de l’ISU ; ce questionnaire en-
voyé à 769 individus et 33 organisations, a reçu 172 ré-
ponses de 30 pays : les stéréoscopistes les plus assidus
et chevronnés apprennent majoritairement cette tech-
nique. Détail dans Stereoscopy n°118, issue 2.2019

Réunion du groupe stéréoscopique de Nouvelle-Aquitaine

P remière réunion de l’année, la plus
riche aussi. Organisée sur un week-

end, les participants qui peuvent séjourner
durant les deux jours disposent de tout le
temps nécessaire pour les échanges. Le
samedi matin, présentation de fantô-
grammes, comme proposé. Six d’entre

nous ont apporté leurs œuvres, Nous n’en
espérions pas tant ! Quelques collègues
ont demandé une démonstration qui les
aidera à se lancer, cela sera fait le
29  mars à Blanquefort. Nous avons aussi
présenté deux livres de Barry Rothstein,
un maître du genre que j’ai rencontré en

VViinnggtt--ssiixxiièèmmee PPhhoott''AAuullnnaayy
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Jacqueline et Jean Trolez reçoivent "Paris en relief" remis par Christian Garnier.
Photo : René Le Menn

Les fantôgrammes, Dominique et Françoise Bretheau, Jean Trolez, Christian Garnier,
Louis Sentis, Benoît Gaubert, Gervais Garnier - Photo : René Le Menn

2007 au congrès ISU de Boise (Idaho). En
fin de matinée, Dominique Bretheau a pré-
senté sur l’écran les étapes de la réalisa-
tion de son fantôgramme du Mont
Saint-Michel d’après Google Earth.

À midi, nous avons fêté les 90 ans du
plus ancien d’entre nous, fondateur de
notre groupe, Jean Trolez. Christian Garnier
lui a remis le livre Paris en Relief et un ma-
gnum de pessac-léognan 2009 de la part
de ses amis aquitains, et Les Diableries of-
fert par le Stéréo-Club Français. Un mo-
ment de joie et d’émotion.

L’après-midi, projections. Louis Sentis,
Le Jura, Village au Fond de la Vallée ;
Éric Pouget, La Côte Atlantique, Les Ro-
chers Sculptés de Rothéneuf ; Domi-
nique Bernardie, La Corse ; René Le
Menn, Madinat al Zahra (Andalousie,
Xe  siècle) ; Gervais Garnier, La Vallée des
Rois (Égypte) vue d’une Montgolfière ; Mi-
chel Dayma, La Ronde des Crèches ;

Dominique Bretheau, Lanternes Chi-
noises, manifestation de nuit graphique
et colorée à Gaillac.

Le samedi soir, nous nous retrouvons ha-
bituellement dans un restaurant d’Aulnay ;
hasard du calendrier et pas de chance, ils
sont tous fermés. Le Foyer Rural a l’aimable
idée de solliciter un traiteur et de nous offrir
le repas. Danielle Garnier considère alors
que le local de nos réunions est un peu
triste le soir. Il faut donc faire simple et
toute la bande augmentée de quelques ex-
posants du lendemain se retrouve dans la
salle à manger de la famille Garnier avec
des tables mises bout à bout et une quanti-
té de chaises sorties de je ne sais où !

Le dimanche, chacun fait ses em-
plettes à la foire à la photo toujours aussi
active ou assiste à l’une des 5 projections
publiques assurées par Benoît Gaubert et
Christian dans la salle de cinéma.

René Le Menn
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U ne carte de profondeur est une re-
présentation de la profondeur d’une

image par des nuances de gris. Ce disposi-
tif a été présenté depuis bien longtemps
au SCF 1).

La séance était centrée sur la mise en
œuvre concrète dans deux cas particuliers,
et cela essentiellement en enchaînant cer-
taines fonctions particulières de SPM.

Les gifs animés de la page d'accueil du
site ont été générés à partir de couples
stéréoscopiques en passant par des cartes
de profondeur permettant de générer
9  images différentes (9 points de vue).
Pour l'autoportrait de la Lettre de février
page 6, une carte de profondeur a été pro-
duite par le téléphone en même temps
que la photo 2D. Cette carte vue par SPM
a servi à générer le couple stéréo.

Pour un gif animé, on enchaîne les
fonctions suivantes de SPM :

• chargement du couple source : File >
Open Stereo Image,

• création de la carte de profondeur :
Edit > Depth map > Create depth map
from stereo pair,

• génération des images : Edit > Depth
map > Create multiple images from 2D +
Depth map,

• réalisation du gif : File > Mo-
vie/Image sequence > Image sequence >
Animation Gif.

Les items de menu sont en anglais car
il faut utiliser une version récente de SPM.

Il est souvent utile de retoucher la
carte de profondeur, cela se fait simple-
ment sous Photoshop ou Gimp.

Autre système : certains téléphones
ont une fonction « portrait » qui consiste à
générer du flou d'arrière-plan (c’est le bo-
keh) ; avec des appareils photo de grand
format, ce type d’effet est obtenu par une
ouverture importante entraînant une faible
profondeur de champ ; c’est impossible
avec les mini-objectifs et capteurs des
téléphones. Pour réaliser cet effet les télé-
phones passent par une carte de profon-
deur, le plus souvent réalisée par un
double objectif. Ainsi le téléphone utilisé

(Samsung S9+) a deux objectifs avec deux
focales différentes ; un assez grand angle
sert à la prise de vue ordinaire, et une fo-
cale plus longue sert au « Mode portrait » ;
dans ce mode, si l’autre objectif n’est pas
masqué, l’appareil génère un fichier com-
prenant l’image 2D et une carte de profon-
deur ; on peut ensuite doser l’importance
du flou d’arrière-plan. SPM sait lire les
photos jpeg comprenant une carte de pro-
fondeur générée par le téléphone (Edit >
Depth map > Open Jpeg include depth
map) puis une simple fonction de SPM gé-
nère le couple stéréo (Edit > Depth map >
Create 3D Image from 2D + Depth map).

Les limites sont importantes ; certaines
sont inhérentes au procédé lui-même et dé-
bouchent sur des artefacts plus ou moins
visibles : il faut « inventer » les parties ca-
chées. Et le pauvre téléphone ne sait pas
bien détecter la profondeur sur des surfaces
réfléchissantes où la position de la surface
diffère de celle de ce qui est reflété. À ces
deux problèmes déjà bien connus s’ajoute
la faible précision des contours.

On peut supprimer des artefacts en re-
touchant la carte de profondeur ; cela a été
fait pour l’autoportrait présenté dans la
Lettre précédente. Mais c’est chronophage !

Plus problématique : la carte de pro-
fondeur générée devient inexploitable
pour des sujets en mouvement ! Pour un
sujet statique, le résultat est meilleur en
cha-cha (en deux temps), qu’il soit traité
avec 3DSteroid donnant lieu à visionnage
immédiat en côte à côte sur le téléphone
avec un OWL, ou traité sur l’ordinateur
avec SPM. L’intérêt stéréoscopique de ce
mode demeure dans le cas rare où
l’appareil de prise de vue est reflété par
un miroir, ce qui fait l’objet d’un challenge
(voir le dernier ISU - Stereoscopy n°119,
page 32).

Les essais n’ont été faits que sur un
modèle de téléphone (S9+). D’autres mo-
dèles sont-ils plus performants ? Cela
reste à tester.

Durant cette même séance un visiteur
nous a présenté des gifs animés remar-

La carte de profondeur sans peine !
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quables. Prise de vue en argentique avec
un Nimslo (datant des années 1980) qui a
la particularité d’avoir quatre objectifs
créant quatre vues bien espacées (format
portrait) ; les 54 mm entre les deux objec-
tifs les plus éloignés permettent de
prendre des sujets assez proches. Les
quatre images ont été montées en gif ani-

mé, en ajustant le point de rotation sur un
élément intermédiaire en profondeur.

François Lagarde

1) Voir détails et quelques références sur le site : Espace
Membres > Pages personnelles > Carte de profondeur,
essais :
https://www.image-en-relief.org/stereo/espace-membres/
pages-personnelles/380-carte-de-profondeur-essais
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Étal de fruits - Photo : François Lagarde (prise au smartphone avec carte de profondeur)

Plantes en pot - Photo : François Lagarde (prise au smartphone avec carte de profondeur)
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P our commencer, un document impres-
sionnant : « L'Arche », de Bernard

Dublique, dessin animé en relief réalisé en
1984 ; ce fut le premier dessin animé en
relief d'Europe. Il a été réalisé avec la
technique traditionnelle du dessin animé
(sans ordinateur)… cellos et gouaches,
gauche et droite, filmés au banc-titre en
16 mm. Le relief est du type bande dessi-
née, avec des éléments plats distribués
dans l'espace… sauf les planètes qui sont
des balles peintes et photographiées en
3D. Ce film a eu un grand succès en 1984
(Médailles d'or aux concours mondiaux, en
France, en URSS et au Japon). Certes la
qualité de ce transfert n'est pas excel-
lente, les dimensions de l'image ne sont
que de 720x576 pixels… mais c'est
maintenant impressionnant ! La version
3D en SBS50 (côte à côte compressé) a
été publiée sur la chaine YouTube du SCF :
https://youtu.be/SCE19x7VwMs
Version 2D sur la chaîne de Bernard Dublique :
https://youtu.be/Ww4A0x7OKds

Les images de plusieurs congrès ISU
réalisées et commentées par Olivier
Cahen (publiées comme albums du site).

Nous avons vu des vidéos de Philippe
Nicolet, prévues pour la séance de
décembre et référencées dans la Lettre
1027 de janvier) : Mémoires gelées du
Léman, le Serpent tricot dans la mer en
Nouvelle-Calédonie, « Subsistance »,

sculpture d'Igor Ustinov. Mais aussi Ama-
zonie - l'Enjeu des rivières volantes
(teaser pour une exposition à Aquatis
Aquarium-Vivarium)
https://youtu.be/HOYtjlxNcWQ

Ainsi que Pilotis, mythes et décou-
vertes https://youtu.be/mOEIsDUQbEk :
documentaire 3D révélant les découvertes
récentes de l’archéologie sur des « Pala-
fittes » (autrefois appelées « Cités la-
custres ») : les habitants préhistoriques de
ces villages occupaient en fait des mai-
sons construites sur les rives émergées ;
les pilotis qui subsistent sont les fonda-
tions de ces habitations.

Grâce à deux diaporamas de Jean-Ma-
rie Sicard on a visité Venise, ses monu-
ments mais aussi les canaux qui se
prêtent à de beaux reflets magnifiés en 3D
et qui servent de voies de transport pour
la vie quotidienne. Vidéos réservées aux
adhérents et référencées dans la Lettre
n°1027 de janvier.

Puis Pierre Meindre nous a fait profiter
de ses nombreuses et passionnantes images
d’un voyage au Nicaragua en 2005. Tout
le monde peut les voir sur son site :
http://www.stereoscopie.fr/Voyages/
AmeriqueLatine/Nicaragua/

Vous pouvez notamment les visionner
avec le visualiseur de Masuji Suto (le
concepteur de SPM) qui permet de

choisir le mode de présentation avec entre

Séance de projection : nouveautés et séance de rattrapage

Sculpture de rhinocéros devant le musée d'Orsay - Photo : François Lagarde

https://youtu.be/SCE19x7VwMs
https://youtu.be/Ww4A0x7OKds
https://youtu.be/HOYtjlxNcWQ
https://youtu.be/mOEIsDUQbEk
http://www.stereoscopie.fr/Voyages/AmeriqueLatine/Nicaragua/?l=FR
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autres 1) la vision parallèle (Para), la vision
croisée (Cross), l'anaglyphe (plusieurs op-
tions) et le côte-à-côte compressé, pour
voir sur TV3D ou avec un projecteur 3D.
Vous pouvez passer en plein écran et aussi
en mode diaporama (Slide) de 1 à 9 se-
condes par images. Attention : plusieurs

images sont croisées, utiliser la fonction
« L-R » échange gauche-droite.

François Lagarde

1) Ces présentations sont similaires à celles des albums
du site du club, en effet ce dernier utilise les fonctions
informatiques du visualiseur de Masuji Suto.

L'extraterrestre, image extraite de la vidéo "L'Arche" - Image : Bernard Dublique

Photo extraite de la vidéo "Amazonie - l'Enjeu des rivières volantes" - Photo : Philippe Nicolet

Photo extraite de la vidéo "Pilotis, mythes et découvertes" - Photo : Philippe Nicolet
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Porteur de vanneries et boutique de poteries à Catarina, Nicaragua en 2005.
Photo : Pierre Meindre

On astique les vieux bus dans la gare routière de San Carlos (Nicaragua, 2005) avant de
longs trajets sur des pistes poussiéreuses - Photo : Pierre Meindre

Les rives du lac Nicaragua à San Carlos (Nicaragua, 2005) - Photo : Pierre Meindre
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9e Congrès ISU Eastbourne en 1993 - Peter Homer devant les projecteurs - Photo : Olivier Cahen

9e Congrès ISU Eastbourne en 1993 - Les spectateurs des projections, au premier plan,
Albert Sieg et sa femme - Photo : Olivier Cahen

19e Congrès ISU, Ljubljana 2013 - Dans le centre ville, vue sur le triple pont sur la rivière
Ljubljanica - Photo : Olivier Cahen

19e Congrès ISU, Ljubljana 2013 - Excursion dans les Alpes slovènes, maisons aux toits
typiques - Photo : Olivier Cahen
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A près avoir assuré pendant de nom-
breuses années le rôle de « Country

Representative » de l’ISU pour la France,
René Le Menn a décidé de passer la main.

C’est votre serviteur qui le remplace
dans ce rôle, après avoir pris sa relève
pour l’ISU Code en septembre 2018.

Votre cotisation à l'association se re-
nouvelle annuellement en décembre.
Cette année, ce sera avec un peu de re-
tard. Mettez-vous à jour dès maintenant,
pour limiter les relances et courriers.

La cotisation annuelle est de 18 €. Une
adhésion pour trois ans bénéficie d’une ré-
duction de 10 %, soit 48 € ; pour cinq ans,

de 20 %, soit 72 € seulement (à peine plus
de 14 euros par an !) et plus de soucis ou
d’oublis.

Pour les nouveaux adhérents, l’adhé-
sion pluriannuelle peut être rétroactive,
cela permet de recevoir immédiatement
les anciens numéros de STEREOSCOPY.

Envoyez votre chèque (à l’ordre du
Stéréo-Club Français) à Thierry Mercier,
58 rue Amelot, 75011 Paris.

Joignez-y un document indiquant vos
nom, prénom, adresse, téléphone, cour-
riel, ainsi qu’une brève description de vos
centres d’intérêt pour la stéréoscopie.

Thierry Mercier

UUnniioonn SSttéérrééoossccooppiiqquuee IInntteerrnnaattiioonnaallee ((IISSUU))
AAddhhééssiioonnss eett rreennoouuvveelllleemmeenntt

AAppppeell aauuxx iimmaaggeess ssttéérrééoo ppoouurr ll''IISSUU CCOODDEE

L ’ISU CODE est un dispositif d'échange
d'images stéréo entre clubs stéréo de

tous les pays. Tous les membres de
chaque club stéréo de l'ISU (Union Stéréo-
scopique Internationale) peuvent partici-
per. Il n’est donc pas nécessaire d’être
membre de l’ISU à titre personnel.

Si vous souhaitez participer à la sélec-
tion proposée par le SCF, je vous demande
de faire parvenir un maximum de
6 couples stéréoscopiques par personne à
tfmercie@club-internet.fr

Sur l’ensemble de vos envois, nous sélec-
tionnerons 10 images que nous transmet-
trons à l’ISU. Ces images seront intégrées par
l’ISU dans un diaporama qui circulera parmi
tous les clubs membres de l’ISU.

Envoyez-moi des couples stéréosco-
piques en côte à côte non compressé. Les
images doivent faire au moins 1080 pixels
de haut et doivent être accompagnées
d’une légende (un nom de fichier suffi-
samment explicite fait tout à fait l’affaire).
Sur ce point, je préfère avoir des images
plus grandes car cela me permet d’effec-
tuer les ajustements éventuellement
nécessaires.

Je transmettrai à l’ISU des images au
double format HD (3840 x 1080 pixels). Si
vos images ne sont pas homothétiques du
format HD, je pourrai ajouter les bandes

noires ad hoc. N’envoyez pas d’ana-
glyphes car cela dégrade trop les cou-
leurs.

Comme ces images sont destinées à
pouvoir être projetées sur grand écran,
l’ISU est particulièrement stricte sur la
quantité de relief admise. Il ne faut pas
dépasser 3,5% de parallaxe à l’infini. Dans
tous les envois à l’ISU que j’ai effectués,
j’ai eu des soucis avec ce critère. Préala-
blement à la sélection finale, c’est un cri-
tère que je serai obligé d’appliquer très
rigoureusement.

Merci d’avance pour vos envois.
Date limite : Dimanche 15 mars. Pour
toutes questions, contactez-moi via mon
adresse mail : tfmercie@club-internet.fr

Thierry Mercier

mailto:tfmercie@club-internet.fr
mailto:tfmercie@club-internet.fr
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Matériel
• Nous avions déjà parlé dans la Lettre de
la société chinoise Insta360. Cette société
créée en 2014 s’est forgé une belle ré-
putation pour ses caméras 360°, pour le
grand public comme pour les profes-
sionnels. Ce qui nous intéresse ici bien sûr
c’est que certains modèles permettent la
prise de vue(s) 3D. Par exemple, la petite
Insta360 EVO (voir Lettre n°1020 p.11) ou
les imposantes (par leurs dimensions et
aussi par leurs prix !) Insta360 Pro 2 et
Insta360 Titan (voir Lettre n°1023 p.16). Insta360 a récemment annoncé un nouveau
modèle nommé Insta360 One R. Ce n’est pas un modèle unique monobloc mais un sys-
tème modulaire avec différents éléments qu’on peut assembler selon différentes con-
figurations. Le cœur du système est le module « core » qui comporte un écran, des bou-
tons de contrôle et des connecteurs pour les autres modules. Viennent ensuite les
modules objectif-capteur, trois sont actuellement proposés : un module 360 avec deux

objectifs fish-eye dos à dos (résolution 5,7K
à 30 img/s, photo 18 MP), un module
simple avec objectif unique grand-angle
(résolution 4K, photo 12 MP) et un module
avancé avec un capteur « 1 pouce » et un
objectif conçu en collaboration avec Leica
(résolution 5,3K, photo 16 MP). Et pour
finir, des bases comportant des batteries :
deux modèles sont proposés, d’encom-
brement et de capacité différents. Et la 3D
alors ? Insta360 a annoncé un kit 3D com-
portant une sorte de monture pour deux
objectifs côte à côte. On a quand même un
peu l’impression que cette version 3D a été
pensée après coup, comme un sous-produit
de l’ensemble. L’écran du module core se
retrouve curieusement sur le côté, ce qui
n’est pas tout à fait idéal pour la visée et le
cadrage !

https://www.insta360.com/product/insta360-oner_1inch-edition
https://www.degreef-partner.nl/fr/blog/insta360-one-r-camera-action-modulaire/
La version 3D n’est pas encore disponible (prévue pour ce printemps), et son prix n’est, lui
non plus, pas connu. Exemples de tarifs pour les versions 2D : Modèle 360° : 479 €. Modèle
4K : 339 €. Modèle 1" : 599 €. Modules objectifs seuls : 360° : 210 €, 4K : 120 €, 1" : 319 €.

• Panasonic a présenté au salon CES de
Las Vegas un prototype de lunettes VR au
look assez particulier. On s’éloigne
effectivement des visiocasques massifs
avec des lunettes (certes qui ressemblent
plus à des lunettes de soudeur qu’à des
lunettes de soleil) pesant environ 150 g.

NNoouuvveeaauuxx pprroodduuiittss

https://www.insta360.com/product/insta360-oner_1inch-edition
https://www.degreef-partner.nl/fr/blog/insta360-one-r-camera-action-modulaire/
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https://www.usine-digitale.fr/article/ces-2020-panasonic-expose-un-prototype-de-
lunettes-de-realite-virtuelle-ultra-compactes.N918539
https://www.realitevirtuelle.com/ces-2020-panasonic-lunettes-realite-virtuelle/

• Le géant chinois des télécoms Huawey
se lance dans la VR avec les Huawei VR
Glass. Avec le poids assez réduit de
166 g, il s’agit plus de lunettes avec des
branches repliables que d’un visiocasque.
Elles sont équipées de deux écrans LCD
de résolution 1600x1600 pixels. La mise
au point des oculaires est ajustable
indépendamment et l’écart entre eux est
aussi réglable. Les branches contiennent
des petits haut-parleurs qui apportent le
son aux oreilles de l’utilisateur. En mode
« mobile » elles ne fonctionnent que sur
certains smartphones du constructeur,
mais on peut aussi les connecter à un
ordinateur sous Windows 10.
Elles sont en priorité destinées au marché
chinois, mais on les trouve aussi sur
certains sites web pour environ 460 $US
avec une petite manette de contrôle avec
trois degrés de liberté.
http://www.gameblog.fr/news/87705-
huawei-vr-glass-huawei-lance-des-lunettes-
de-realite-virtuel
https://www.vopmart.com/huawei-vr-glass.html

• La société Looking Glass complète sa gamme avec un nouveau modèle de bien plus
grande taille : le Looking Glass 8K Immersive Display est basé sur un écran
27  pouces de résolution 8K (7680 x 4320 pixels) qui propose 45 points de vue. Le site
web du constructeur n’indique pas de prix mais il sera sans doute bien supérieur au
modèle 15,6" qui coûte déjà 3000 $US (600 $US pour le petit modèle 8,9").
https://lookingglassfactory.com/product/8k

Pierre Meindre

La gamme des écrans 3D Looking Glass

https://www.usine-digitale.fr/article/ces-2020-panasonic-expose-un-prototype-de-lunettes-de-realite-virtuelle-ultra-compactes.N918539
https://www.realitevirtuelle.com/ces-2020-panasonic-lunettes-realite-virtuelle/
http://www.gameblog.fr/news/87705-huawei-vr-glass-huawei-lance-des-lunettes-de-realite-virtuel
https://www.vopmart.com/huawei-vr-glass.html
https://lookingglassfactory.com/product/8k
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CClluubbss ssttéérrééooss ééttrraannggeerrss
• PHG 3D, Vienne, Autriche

La section stéréo de la Photographische Gesellschaft de
Vienne, Autriche (ou PHG 3D pour faire plus court !) organise
son 9e concours international de photos stéréos.
Tout stéréoscopiste peut envoyer de une à quatre photos nu-
mériques : paire stéréo en JPEG du sujet de son choix avant
le 1er avril 2020. Les photos seront jugées par un jury compo-
sé d’au moins cinq experts internationaux en photographie
2D ou 3D. Les images retenues seront publiées sur le site web
de la PHG 3D et envoyées électroniquement à tous les partici-

pants. Projection en juin 2020 en Autriche.
Plus d’information sur la page : http://www.die3dimensionale.at/en/3d-contest
Les résultats des 8 concours précédents peuvent être vus sur cette page :
http://www.die3dimensionale.at/en/3d-gallery-en

• Ohio Stereo Photographic Society, USA
Le club stéréo de l’Ohio, la Ohio Stereo
Photographic Society (OSPS) organise depuis

2001 le concours international de photos stéréos OISE (Ohio International Stereo
Exhibition) qui suit les règles de la PSA, la fédération photo américaine.
Chaque participant peut envoyer jusqu’à 4 images sur le thème de son choix. Il doit
s’agir de photographies (pas de dessins ou d’images de synthèse par exemple). Taille
maximale du couple : 3840x1080 pixels enregistré en mode parallèle dans un fichier
JPEG. Donner un titre à chaque photo. Les droits de participation sont de 10 $US par
participant (pas par photo !) payables par PayPal.
Les images doivent être envoyées au plus tard le 25 avril 2020. Le jury siègera le 2 mai
et les résultats seront annoncés le 16 mai 2020.
Plus d'informations sur le site web : https://ohiostereoexhibition.com/

• Stereoscopic Society, Royaume-Uni
La Stereoscopic Society organisera sa convention annuelle
du vendredi 1er au lundi 4 mai 2020 à Harrogate dans le
Yorkshire pour des projections 3D et se retrouver pour parler

de stéréoscopie.
Harrogate est une charmante ville thermale du nord de l’Angleterre (à 22 km au nord de
Leeds), entourée de parcs et de parterres de fleurs. Elle est encore plus ravissante au
printemps où les fleurs mettent en valeur sa belle architecture de ville thermale anglaise.
Le site du congrès sera l’hôtel Cedar Court, un très bon hôtel 4 étoiles à proximité des
gares ferroviaire et routière, qui logera les participants et où auront lieu également les pro-
jections. Le dimanche, une excursion pour la journée est prévue à Harewood House (grande
demeure du XVIIIe siècle) et à Knaresborough (petite ville thermale et son château).
Plus d'informations sur le site web de la Stereoscopic Society :
http://www.stereoscopicsociety.org.uk/WordPress/next-conference/

• Deutsche Gesellschaft für Stereoskopie (DGS), Allemagne
La DGS organisera son congrès annuel du vendredi 12 juin au
lundi 15 juin 2020 à Nördlingen dans le sud de l’Allemagne.
Nördlingen est une petite ville de Bavière dont le centre a
gardé un aspect médiéval très bien préservé, est encore
entièrement ceint de remparts et est dominé par les

90 mètres du Daniel, un impressionnant clocher gothique. La ville est desservie par le

https://ohiostereoexhibition.com/
http://www.die3dimensionale.at/en/3d-gallery-en
http://www.stereoscopicsociety.org.uk/WordPress/next-conference/
http://www.die3dimensionale.at/en/3d-contest
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Sculptures du Bénin, exposition "Là où l'âme se plaît", Carrousel du Louvre, janvier 2020.
Photo : Jean-Yves Gresser

Sculptures du Bénin, exposition "Là où l'âme se plaît", Carrousel du Louvre, janvier 2020.
Photo : Jean-Yves Gresser

train et les aéroports les plus proches sont Stuttgart, Nuremberg et Munich. De ces villes
compter ensuite de 2 heures à 2h30 de train. Au cœur de la vielle ville l’hôtel Klösterle,
situé dans un ancien monastère franciscain, logera les congressistes et sera le lieu des
projections 3D (118,90 € la chambre double, 104 € la simple, petit déjeuner compris).
Des excursions sont prévues : visite de la ville, visite du Ries Crater Museum
(météorites), visite du musée ferroviaire de Bavière et, le lundi, excursion à
Schillingsfürst et son château baroque des princes de Hohenlohe-Schillingsfürst.
Plus d’informations sur le site web de la DGS :
https://www.stereoskopie.org/en/events/dgs-congresses/3d-kongress-der-dgs.html
Vidéo 3D de présentation du congrès : https://youtu.be/VCTMRvpyjX0
Brochure touristique de la ville (en français) :
https://www.noerdlingen.de/fileadmin/noerdlingen/prospekte/pdf/Ortsprospekt_Englisch-
Franzoesisch_2019.pdf

https://www.stereoskopie.org/en/events/dgs-congresses/3d-kongress-der-dgs.html
https://youtu.be/VCTMRvpyjX0
https://www.noerdlingen.de/fileadmin/noerdlingen/prospekte/pdf/Ortsprospekt_Englisch-Franzoesisch_2019.pdf
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• Lors du dernier congrès ISU en Allemagne, le
Tchèque Mat j Boháč avait apporté un
superbe stéréoscope en bois de sa fa-
brication. Le bois provient d’un noyer de son
jardin, longuement séché durant plusieurs an-
nées, et les oculaires sont des doublets
achromatiques (focale 100 mm, 33 mm de
diamètre) fournis par Jeroen de Wijs. Pour
afficher les images, Mat j a utilisé un smart-
phone Sony Xperia XZ Premium qui a la
particularité d’avoir un écran de résolution 4K.
Le soin de la réalisation, la qualité des optiques,

la finesse de l’écran, tout ceci magnifie les déjà superbes images stéréos de Mat j ! Sur
ce site web, il décrit en détail cette réalisation :
http://klub.stereofotograf.eu/digital_stereoscope.php
Détail technique intéressant : la page explique aussi comment modifier le paramétrage
du téléphone de manière à ce que toutes les applications (et pas seulement celles de
Sony) puissent exploiter la résolution 4K du téléphone.

• Les musées de la ville de Paris ont récemment mis sur leur site web de nombreuses
numérisations de photos stéréos anciennes, cartes et plaques de verre.
http://parismuseescollections.paris.fr/fr/denomination/vue-stereoscopique?mode=mosaique
On remarquera une photo amusante : dans l’ancienne usine Jules Richard, une façade
peinte d’une immense mire qui était utilisée pour le réglage des objectifs !

• Sur le site web du journal The New York Times, un article du 14 décembre 2019 de
Steven Kurutz ”Virtual Reality Before There Was Virtual Reality” (la réalité virtuelle avant
que la réalité virtuelle n’existe) qui décrit un spectacle d’Eric Drysdale qui utilise une
quinzaine de stéréoscopes Realist et des diapos stéréos des années 1940 et 1950.
https://www.nytimes.com/2019/12/14/style/nostalgic-american-photos.html

VVuu ssuurr llaa ttooiillee

http://klub.stereofotograf.eu/digital_stereoscope.php
http://parismuseescollections.paris.fr/fr/denomination/vue-stereoscopique?mode=mosaique
https://www.nytimes.com/2019/12/14/style/nostalgic-american-photos.html


Page 19

LLeettttrree mmeennssuueellllee dduu SSttéérrééoo--CClluubb FFrraannççaaiiss

MMaarrss 22002200 -- nn°°11002299

• Le site de modélisation 3D
Sketchfab a lancé un
programme open-source pour
inciter les musées et les
institutions culturelles à faire des
copies numériques des œuvres
en leur possession. Un
partenariat a ainsi été signé
avec 27 musées de 13 pays
différents. On peut afficher
certaines œuvres (comme cette
tête d'Amenhotep III ci-contre)
dans une interface spécifique,
les faire tourner dans tous les
sens et aussi sélectionner un
mode VR qui affiche en côte à
côte compressé. Passer ensuite
en mode plein écran pour
regarder sur une TV3D ou un casque de VR comme les Oculus Go ou Quest.
https://www.roadtovr.com/sketchfab-public-domain-3d-assets/

• Le réalisateur et stéréographe Fabien Remblier prépare le tournage de son prochain
court-métrage en 3D « Jean », d’une durée de 22 minutes, avec Patrick Chesnais,
Damien Jouillerot, Naïme Haïne et François Rocquelin, et qui sera tourné dans la région
d'Aix-en-Provence. Pour boucler son budget, il a mis en place un financement participatif
sur le site proarti.fr : les dons à partir de 30 € (dont 66% déductibles des impôts) y sont
les bienvenus. Soutenons les réalisateurs 3D français !
https://www.proarti.fr/collect/project/jean/0

Pierre Meindre

19e Congrès ISU, Ljubljana 2013 - Le port de Piran sur l'Adriatique - Photo : Olivier Cahen

Managua, Nicaragua, les restes de la statue équestre du dictateur déchu - Photo : Pierre Meindre

https://www.roadtovr.com/sketchfab-public-domain-3d-assets/
https://www.proarti.fr/collect/project/jean/0
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Paiement France : chèque (sur une banque française seulement) à l'ordre du Stéréo-Club Français.
Étranger : mandat international ou par Internet. Adressez votre chèque à l’adresse ci-dessous :

Michel Mikloweit, Trésorier du SCF - 7, rue Raoul Dautry 91190 Gif-sur-Yvette
Paiement par Internet : www.image-en-relief.org, menu Adhésion

Membre de l'ISU (Union stéréoscopique internationale)
https://www.isu3d.org

et de la FPF (Fédération photographique de France)
http://federation-photo.fr

SIRET : 398 756 759 00047 – NAF 9499Z
Siège social : Stéréo-Club Français

46 rue Doudeauville
75018 Paris

Président du SCF, directeur de la publication : Patrick Demaret
Vice-président : François Lagarde. Secrétaire : Thierry Mercier. Trésorier : Michel Mikloweit.

Rédacteur en chef de la Lettre : Pierre Meindre - bulletin@image-en-relief.org

Cotisation 2020
Tarif normal : . . . . 65 €
Première année d'adhésion : 22 €
Tarif réduit (non imposable avec
justificatif) : . . . . . . . . . . . . . . 22 €

Valable du 1er janvier au 31 décembre.
À partir du 1er novembre et jusqu’à la
fin de l’année suivante
pour les nouveaux
adhérents.

ISSN 1774-8569
Dépôt légal mars 2020

HHoommmmaaggee
Nous apprenons le décès de Henri-Jean Morel survenu le 6 février 2020 à l'âge de
87 ans. Il a été membre du SCF de 1991 à 2017. Le Stéréo-Club Français conserve les
images qu’il avait confiées au site du Club en 2010 :
https://www.image-en-relief.org/archive/Galeries_Wiki/Morel_Henri_Jean
Toutes nos condoléances à ses proches.

Le Stéréo-Club Français

Bouquet de pivoines arbustives, 07-07-2009 - Photo : Henri-Jean Morel

http://www.image-en-relief.org
https://www.isu3d.org
http://federation-photo.fr
https://www.image-en-relief.org/stereo/adhesion
mailto:bulletin@image-en-relief.org
https://www.image-en-relief.org/archive/Galeries_Wiki/Morel_Henri_Jean

